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Microsoft Office 2013 is a comprehensive, interactive set of applications designed to accomplish a wide arrange 

of business needs. Each application has specific areas of strength but the intent is for these applications to be 

integrated easily, and for products created in them to be shared quickly and securely.  

 

Program Description 

Word 2013 Word processor used to create text based documents 

Excel 2013 Spreadsheet program used to analyze numerical data and create reports 

PowerPoint 2013 Graphical presentation program used to create presentation materials 

Outlook 2013 Desktop organizer and messaging client 

One Note 2103 Note-taking and information organization tools 

Access 2013 Database manager used to organize manage and display a database 

 

All of the programs have similar appearances, features and controls. This document is a highly recommended 

prerequisite to any of the Microsoft Office courses offered by the Computer Training Center (CTC). It will 

outline how to open and navigate the layout of these applications and help identify which application is best 

suited to accomplish certain workplace tasks. With these introductory understandings in your back pocket, you 

will be prepared to accomplish the intermediate-to-advanced skills addressed in CTC workshops. 
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Common Features of the Microsoft Office Interface 

This section will walk you through the common interface and application features so you can get a feel for how 

Office 2013 works. We will use Microsoft PowerPoint to illustrate these features. 

The “User Interface” is a set of graphical elements that are designed to help you interact with the program and 

provide instructions as to the actions you want the application to perform. These include: 

 The Ribbon 

 The Quick Access Toolbar 

 Menus 

 Dialog boxes 

 The File Tab and Backstage View 

 

Starting an Office 2013 Application 

To demonstrate these common features, you will need to start the PowerPoint application. The most common 

method to open an application is to double click on the application   icon on the desktop. This process works 

the same with all Microsoft Office applications, such as Word, Excel and Outlook: 

     

 

Usability Tip: Alternatively, you can open applications by searching for them in the explorer or going to 

their location from the Start menu: All Programs | Microsoft Office 2013. 

 

When a Microsoft Office application is started, it displays the Start screen, which displays a list of recently 

opened documents on the left and a gallery of thumbnail images of available templates in the center. Microsoft 

Office applications default to the “Blank Presentation/Document” thumbnail, which is used to create content 

from scratch. 

Recent 
Presentation
s 

Templates 
Gallery 
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The blank presentation template displays in the PowerPoint window. The center of the title bar displays the file 

name and program name (PowerPoint in this case). At either end of the title bar, there are buttons, graphical 

elements that perform actions when clicked using the mouse. First is the Window button, which allows you to 

size, move, and close the application window. To the right of the Window button is the Quick Access Toolbar 

(QAT) which hosts frequently used commands. It includes Save, Undo, and Repeat commands by default. You 

can customize the QAT with your own frequently used buttons by selecting the dropdown. 

On the right side, five more buttons display The Help button  which accesses the program’s help system. 

The Ribbon display options button  controls the display of the tabs and ribbon, with options to display the 

tabs and ribbon. The last three buttons are controls for the size of the window -- minimizing, maximizing, or 

closing the application.  

Below the title bar is the Ribbon, which houses a large arsenal of commands and tools to work in your 

document.  The far right hand side of the ribbon is a login icon which indicates whether you are logged into 

Microsoft Office’s online services. The location and structure of the ribbon is the same in all the Office 

applications, but specific commands will vary by application. 

 

 

  

Quick 
Access 
Toolbar 

Ribbon 

Document 
Window 

Status 
bar 
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The main section of the screen is known as the document window. It displays open application files. In 

PowerPoint it is a blank presentation; in Microsoft Word, it would display as a document; in Excel it would 

display as a blank workbook. To the right of the document window is a vertical scroll bar which allows you to 

move up and down in the document to view new information. A horizontal scroll bar at the bottom of the 

window allows you to move left and right within the document. The scroll bar will not appear in the window 

unless it is necessary. 

The bottom of the application displays another common feature of Microsoft Office applications, the status 

bar. It contains information about the file you have open, as well as features to help you view the file. Like the 

ribbon, the specific contents of the status bar will vary depending on the application open. 

All of the Office applications’ status bar contain view buttons that are used to change how the content of the 

page is shown. Finally, there is a zoom slider at the far right of the status bar which can be dragged left and 

right to “zoom in” or “zoom out” to see the appropriate amount of the document. 

  

Using the Ribbon  

 

 

 

 

 

The Ribbon has three basic parts: tabs, groups, and commands. Tabs are used to divide the ribbon into related 

activity areas. Each tab is then divided into Groups made up of related items. These items are commands. 

Selecting a command either performs the action or displays a list of additional options. The content of the 

Ribbon tab will vary from application. The following section will focus on the capabilities and features of each 

application’s ribbons and capabilities.  
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Backstage View 

The Backstage View includes many tasks that were traditionally located in Tools and Options in previous 

versions of PowerPoint.  While the ribbon contains commands for working in a PowerPoint file, the Backstage 

View contains commands to do things to a PowerPoint file. 

Click the File Tab to access the Backstage View.   

 Options include Save As, Open, Print, Help and Exit.  

 Click Info to apply protection, to check for issues and manage versions.  

 Click Options to adjust your preferences. 

 

 

Common Keyboard Shortcuts 

Microsoft Office contains a series of keyboard shortcuts designed to simplify the user’s experience. While each 

individual application has its own specific shortcuts that carry out specific actions, there are some general 

shortcuts that function across the entire suite: 

 

Function Copy Cut Find Go To Help Hyperlink New Open 

Shortcut Ctrl + C Ctrl + X Ctrl + F Ctrl + G F1 Ctrl + H Ctrl + N Ctrl + O 

         

Function Paste Print Replace Save 
Select 

All 

Spell 

Check 
Undo Redo 

Shortcut Ctrl + V Ctrl + P Ctrl + H Ctrl + S Ctrl + A F7 Ctrl + Z Ctrl + Y 
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PowerPoint 2013 Features 

Although creating an effective presentation is a complicated process, PowerPoint 2013 helps simplify this 

process by providing assistance in the content development phase, as well as in the layout and design phase. 

PowerPoint includes features such as text handling, outlining, graphing, drawing, animation, clip art, and 

multimedia support. In addition, the program suggests layouts for different types of presentations and offers 

professionally designed templates to help you produce a presentation that is sure to keep your audience’s 

attention. In addition, you can quickly produce the support materials to be used when making a presentation. 

Develop, Enter, and Edit Content 

The content development phase includes deciding on the topic of your presentation, the organization of the 

content, and the ultimate message you want to convey to the audience. As an aid in this phase, PowerPoint 2013 

helps you organize your thoughts based on the type of presentation you are making by providing both content 

and design templates. Based on the type of presentation, such as selling a product or suggesting a strategy, the 

template provides guidance by suggesting content ideas and organizational tips. For example, if you are making 

a presentation on the progress of a sales campaign, the program would suggest that you enter text on the 

background of the sales campaign as the first page, called a slide; the current status of the campaign as the next 

slide; and accomplishments, schedule, issues and problems, and where you are heading on subsequent slides.  

Design Layouts 

The layout for each slide is the next important decision. Again, PowerPoint 2013 helps you by suggesting text 

layout features such as title placement, bullets, and columns. You also can incorporate graphs of data, tables, 

organizational charts, clip art, and other special text effects in the slides. PowerPoint 2013 also includes 

professionally designed themes to further enhance the appearance of your slides. These themes include features 

that standardize the appearance of all the slides in your presentation. Professionally selected combinations of 

text and background colors, common typefaces and sizes, borders, and other art designs take the worry out of 

much of the design layout. 

Deliver Presentations 

After you have written and designed the slides, you can use the slides in an onscreen electronic presentation or a 

Web page. An onscreen presentation uses the computer to display the slides on an overhead projection screen. 

As you prepare this type of presentation, you can use the rehearsal feature that allows you to practice and time 

your presentation. The length of time to display each slide can be set and your entire presentation can be 

completed within the allotted time. A presentation also can be modified to display on a Web site and run using a 

Web browser. Finally, you can package the presentation to a CD for distribution. 
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Command Tabs 

Command Tab Home: Clipboard, Slides, Font, Paragraph, Drawing and Editing 

 

Command Tab Insert:  Slides, Tables, Images, Illustrations, Apps, Links, Comments, Text, Symbols and Media 

 

Command Tab Design:  Themes, Variants and Customize 

 

Command Tab Transitions:  Preview, Transition to This Slide and Timing 

 

Command Tab Slide Show:  Start Slide Show, Set Up and Monitors 

 

Command Tab Review: Proofing, Language, Comments, Compare and OneNote 

 

Command Tab View:  Presentation Views, Master Views, Show, Zoom, Color/Grayscale, Window and Macros 
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PowerPoint Views 

There are several views in PowerPoint – Normal, Outline, Slide Sorter, Notes Pages, Reading View and Slide 

Master Views.  There are specific scenarios for which each view is the preferred view.  Below are screenshots 

of the views and the preferred uses for each.  To access the views, click View Tab or use the View buttons in 

the bottom right cover of the screen.   

Normal View:  Best used for editing and inserting objects on the slide  

 Normal view includes the Slide/Outline pane to the left with thumbnails of the slides to use to navigate, 

a large view of the slide itself and the Notes Page pane at the bottom to enter the speaker’s notes. 

 

Outline View:  Best used to enter text in bulleted lists 

 In the Outline view, you can type the text without concern for placement or other objects.   

 To indent a bullet, press Tab.   

 To promote a bullet, press Shift + Tab.  You can also use the Promote and Demote buttons  on 

the Home tab. 
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Slide Sorter View:  Best used to apply transitions, move, delete or copy slides 

 To apply a transition, select all the slides, click Transitions Tab, and apply a Transition from the 

Gallery provided.  

 To copy a slide, right-click on the slide and select Copy from the shortcut menu.  Move to the insertion 

point and paste. 

 To delete a slide, click on the slide and press the Delete key on your keyboard. 

 To move a slide, click on the slide and hold your mouse.  Drag the slide to the new position and release 

the mouse. 

 

 

Notes Pages View:  Best used when entering the speaker’s notes. 

 This view displays the slide in a half page format with the Notes data entry field below it.   

Click into the Notes page frame and type the notes for each slide 
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Microsoft Word 2013 Features 

 

Edit Content 

Word 2013 gives users the ability to quickly and efficiently edit a document. Basic document editing involves 

correcting spelling, grammar, and sentence-structure errors and revising or updating existing text by inserting, 

deleting, and rearranging areas of text. For example, a document that holds employee contact information can 

easily be updated to reflect new hires. A document that details processes can be revised by removing old 

processes and inserting new ones. Many of these changes are made easily by cutting or copying selected text 

and then pasting the cut or copied text in another location in the same or another document.  

To support your production of a perfect document, Word 2013 utilizes many additional editing support features. 

The AutoCorrect feature monitors the spelling and grammar in a document in real time. Common errors are 

corrected automatically for you. AutoCorrect identifies other errors and suggests options for correction. A 

thesaurus can be used to display alternative words that have a meaning similar or opposite to a word you 

entered. The Find and Replace feature can be used to quickly locate specified text and replace it with other text 

throughout a document. In addition, Word 2013 includes a variety of tools that simplify the process of many 

common tasks, such as creating tables, form letters, and columns. 

Format Content 

You also can easily control the appearance or format of the document. The most obvious formatting tool is the 

ability to apply different fonts (letter styles and sizes) and textual appearance changes such as bold, italics, and 

color to all or selected portions of the document. Additionally, you can add color shading or background images 

behind lines of text, entire paragraphs, or whole pages to add contrast or signal importance. Other formatting 

features include changes to the document as a whole, such as the line spacing and alignment of text between the 

margins. You also can format the document by customizing page numbers and margin settings 

Status bar 

Ribbon 

Document 
Window 

Quick Access Toolbar 
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To make formatting even easier, Word 2013 includes Document Themes and Styles. Document Themes 

automatically apply a consistent font, color, and line effect to a document. Styles apply the selected style design 

to a selection of text. Further, Word 2013 includes a variety of built-in preformatted content that helps you 

quickly produce modern-looking, professional documents. Among these are galleries of cover page designs and 

header and footer designs. While selecting many of these design choices, a visual gallery is displayed, making it 

easy to see how the design would look in your document. In addition, you can select from a wide variety of 

templates to help you get started on creating many common types of documents such as flyers, calendars, faxes, 

newsletters, and memos. 

Insert Illustrations and Videos 

To enhance the appearance of your documents, you can insert many different types of graphic elements. These 

include drawing objects, SmartArt, charts, pictures, clip art, screenshots, and videos. The drawing tools supplied 

with Word 2013 can be used to create your own drawings, or you can select from over 100 adjustable shapes 

and modify them to your needs. All drawings can be further enhanced with 3-D effects, shadows, colors, and 

textures. SmartArt graphics allow you to create a visual representation of your information. They include many 

different layouts such as a process or cycle that are designed to help you communicate an idea. 

Charts can be inserted to illustrate and compare data. Complex pictures can be inserted in documents by 

scanning your own, using supplied or purchased clip art, or downloading images from the Web. Additionally, 

you can quickly capture and insert a picture, called a screenshot, from another application running on your 

computer into the current document. Finally, you can easily find and insert videos from different online sources 

to enhance your document.  

 

 

Command Tabs 

Command Tab Home: Clipboard, Font, Paragraph, Styles and Editing  

 

 

Command Tab Insert: Pages, Tables, Illustrations, Apps, Media, Links, Comments, Header & Footer, Text and 

Symbols 
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Command Tab Design: Themes, Document Formatting and Page Background  

 
 

Command Tab Page Layout: Page Setup, Paragraph and Arrange  

 
 

Command Tab References: Table of Contents, Footnotes, Citations & Bibliography, Captions, Index and Table 

of Authorities  

 
 

Command Tab Mailings: Create, Start Mail Merge, Write & insert Fields, Preview Results and Finish  

 
 

Command Tab Review: Proofing, Language, Comments, Tracking, Changes, Compare, Protect and OneNote  

 
 

Command Tab View: Views, Show, Zoom, Window and Macros  
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Excel 2013 Features 

 

Excel 2013 includes many features that not only help you create a well-designed worksheet, but one that 

produces accurate results. The features include the ability to quickly edit and format data, perform calculations, 

create charts, and print the spreadsheet. Using Excel 2013, you can quickly analyze and manage data and 

communicate your findings to others. The program not only makes it faster to create worksheets, but it also 

produces professional-appearing results. 

Enter and Edit Data 

The Microsoft Excel 2013 spreadsheet program uses a workbook file that contains one or more worksheets. 

Each worksheet can be used to organize different types of related information. The worksheet consists of rows 

and columns that create a grid of cells. You enter numeric data or descriptive text into a cell. These entries can 

then be erased, moved, copied, or edited. 

Format Data 

Like text in a Word document, the design and appearance of entries in a worksheet can be enhanced in many 

ways. For instance, you can change the font style and size and add special effects such as bold, italic, borders, 

boxes, drop shadows, and shading to selected cells. You also can use cell styles to quickly apply predefined 

combinations of these formats to selections. Additionally, you can select from different document themes, 

predefined combinations of colors, fonts, and effects, to give your workbooks a consistent, professional 

appearance. 

Unlike the Word application, Excel includes many formatting features that are designed specifically for numeric 

data. For example, numeric entries can be displayed with commas, dollar signs, or a set number of decimal 

places. Special formatting, such as color bars, can be applied automatically to ranges of cells to emphasize data 

based on a set of criteria you establish and to highlight trends.  
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Analyze Data 

The power of a spreadsheet application is its ability to perform calculations from very simple sums to the most 

complex financial and mathematical formulas. Formulas can be entered that perform calculations using data 

contained in specified cells. The results of the calculations are displayed in the cell containing the formula. 

Predefined formulas, called functions, can be used to quickly perform complex calculations such as calculating 

loan payments or performing a statistical analysis of data. 

Analysis of data in a spreadsheet once was too expensive and time-consuming. Now, using electronic 

worksheets, you can use what-if or sensitivity analysis by changing the values in selected cells and immediately 

observing the effect on related cells in the worksheet. Other analysis tools such as Solver and Scenarios allow 

you to see the effects of possible alternative courses of action to help forecast future outcomes.  

Chart Data 

Using Excel, you also can produce a visual display of numeric data in the form of graphs or charts. As the 

values in the worksheet change, charts referencing those values automatically adjust to reflect the changes. You 

also can enhance the appearance of a chart by using different type styles and sizes, adding three-dimensional 

effects, and including text and objects such as lines and arrows.  

 

Command Tabs 

Command Tab Home: Clipboard, Font, Alignment, Number, Styles, Cells, and Editing. 

 

 

Command Tab Insert:  Tables, Illustrations, Apps, Charts, Reports, Sparklines, Filter, Links, Text and Symbols. 

 

 

Command Tab Page Layout:  Themes, Page Setup, Scale to Fit, Sheet Options, and Arrange. 

 

 

Command Tab Formulas:  Function Library, Defined Names, Formula Auditing and Calculation. 
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Command Tab Data:  Get External Data, Connections, Sort & Filter, Data Tools, and Outline 

 

 

Command Tab Review:  Proofing, Language, Comments, and Changes. 

 

 

Command Tab View:  Workbook Views, Show, Zoom, Window, and Macros. 
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